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The owner of this manual used a lot of time and 
money to compile it 
 
 If you find this manual helpful please donate  
 If you will need the assignments and final 

examination to be marked to receive a basic 
certification please donate 

 
Donation account 
 
 Please write to obtain an account information  

Email: lembu@kivuyo.com  
 
Other manuals are: 

1. Advanced internet & emails management 
2. Introduction to micro computers 
3. PC Construction and management 

a. Introduction to computers, customer needs analysis, 10 
steps to construct a PC , troubleshooting, OS installation 
and configuration and information security 

4. Computerised accounting 
5. Webdesign and hosting 
6. Information security 
7. MS Office Applications 

a. MS Word, MS Excel, MS Access, MS Publisher, MS 
PowerPoint, MS Outlook,  

 
Please visit www.kivuyo.com  or www.infocomcenter.com  for more details 
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Lesson #1  

1.0 Introduction 
 
Internet Evolution 
 
The World Wide Web was originally developed in 1990 at CERN, the European 
Laboratory for Particle Physics. The original idea came from a young computer 
scientist, Tim Berners-Lee. It's now managed by The World Wide Web Consortium.  

The W3 Consortium, funded by a large number of corporate members, including 
AT&T, Adobe Systems, Inc., Microsoft Corporation and Sun Microsystems, Inc., 
promotes the growth of the Web by developing technical specifications and reference 
software made freely available to everyone.  

What is Internet? 
Internet comes from two words Inter – Networks, 
It means that connecting various networks of computers throughout the globe in the 
form of web net 
 
Two types of networks are Local Area Network (LAN) and Wide Area Network (WAN). 
We have also other types of wide area networks like Intranet and Extranets 
 
Definition: 
 
Internet is the set of networked computers at various localities of the world that are 
connected using the TCP/IP protocols  

These computers are all together webbed in the system called World Wide Web or in 
short www. There are also other networks apart from www which constitute to the 
internet 

  
World Wide Web (www) 
 
Think of the World Wide Web as a vast collection of electronic files stored on millions of 
computers all around the world. Hypertext links these files together. Uniform 
Resource Locators or URLs are the addresses used to locate the files. The 
information contained in a URL gives you the ability to jump from one web page to 
another with just a click of your mouse. When you type a URL into your browser or click 
on a hypertext link, your browser sends a request to a remote computer, called a web 
server, to download one or more files. Every  
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URL is unique and identifies one specific file.  

What does a typical URL look like? Here are a few examples: 

http://www.infocomcenter.com 
The home page for InfoCom Center which cab be retrieved using hypertext 
transfer protocol method (http) .  

ftp:// infocomcenter.com  
The home page for InfoCom Center which cab be retrieved using file transfer 
protocol method (ftp) .  

The first part of a URL (before the two slashes) tells you the type of resource or method 
of access at that address. For example:  

 http - a hypertext document or directory  

 ftp – Files Transfer Protocol  

The second part is typically the address of the computer where the data or service is 
located. Additional parts may specify the name of a file, the port to connect to, or the 
text to search for in a database. 
 
Assignment for lesson #1 …………………………………………. 
 

1. What do you know about w3 consortium? 
2. What is Internet? 
3. Explain the function of the following URL parts 
4. http://www.domainname.com 
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Lesson #2   The Explorer Toolbars 
 

Web browser  
 
A web browser is the software program you use to access the World Wide Web, the 
graphical portion of the Internet. The first browser, called NCSA Mosaic, was developed 
at the National Center for Supercomputing Applications in the early 1990s. The easy-to-
use point-and-click interface helped popularize the Web, although few could then 
imagine the explosive growth that would soon occur.  

The Top Three 

1.

 

Opera 

 
The gold award leading browser according to Top Ten Reviews Website  
www.toptenreviews.com  

2.

 

Internet Explorer 

 
The silver award leading browser according to Top Ten Reviews Website  
www.toptenreviews.com 

3.

 

FireFox 

 
The bronze award leading browser according to Top Ten Reviews 
Website  
www.toptenreviews.com  
Firefox, a more recent entry, was released in November 2004; version 
2.0, with enhanced security and other new features was released in 
October 2006 and has been updated periodically. 
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Since the three browsers above have more similarities than differences, we'll primarily 
cover one of this browser which is Internet Explorer.  

For the most up-to-date information about each browser and a complete tutorial, check 
the online handbook under the Help menu or go to the websites of the respective 
software companies. 

Browser Anatomy 

At least all internet browsers have in common the following parts: 

 

1. Title bar 
2. Bar Menu 
 

3. Standard buttons 
4. Address Bar 
 

5. Main Display Window  

6. Status Bar 
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How Internet Works 
Learn how LAN and WAN Works 
Local Area Network 
The computers within a building or an office communicate through a server or a switch 
hub. The hub or server store the necessary resources required for communication. The 
computers in the network are called client computer or workstation.  
 

When you're online, your computer, known as a client, requests information from a 
remote computer, known as a server. To do this, you click on a link. This instructs the 
server to send you the information you requested. Think of all the clicking you do as 
you surf the Web. Although it may seem insignificant, to some people, your clickstream 
has great value.  
 
Most websites, including Learn the Net, store data about visitors to the site. For 
instance, we know what site you came from, which pages you visited, how long you 
stayed on the site, which files you downloaded, and many other related bits of 
information about your activities. If you register with a website, the site can identify who 
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you are each time you visit. (But even if you didn't register, it's still possible to discover 
who you are by matching records from your Internet Service Provider or ISP.)  

All this information is stored in log files that the site operator can analyze. The 
information is typically used to improve the website and deliver personalized and more 
relevant content. For instance, we know that many Learn the Net visitors read articles 
about e-mail, so we try to publish more information about this subject. Understanding 
readers' preferences also helps publishers attract advertisers of interest to its audience. 
While web publishers only have user data from their own sites, your ISP has a 
complete record of every click you make online. In the wrong hands, this click stream 
data can pose a serious threat to your privacy.  

 
 
What is Internet Explorer? 

Internet Explorer is the Microsoft Web Browsing program. It helps the user to connect to 

Web sites. Surf the Websites using hypertext links to search, view, learn, play games, 

audio, video, movies and or download files and program from the Internet to his/her own 

computer. 

 

The versions of ie are expressed by digit and decimals where left of decimal denote 

major change of the browser and the right part of the decimal denote minor changes. 

Internet Explorer 4.0 released with Windows 98 

Internet Explorer 5.0 

Internet Explorer 5.5 released with Windows 2000 

Internet Explorer 6.0 released with Windows XP 

Internet Explorer 7.0 released with Windows Vista 

Internet Explorer 8.0 released with Windows 7 
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Internet Explorer can be launched directly from the computer's desktop, quick  

launch or from Windows Start menu (pinned program area or all programs) 

Reasons why pages cannot be displayed for sometime? 

If the there is no network or the website is encountering problems or there is URL typing 

error, then the page display will be shown as illustrated below 

 

 
 

Launching Internet Explorer 
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Using the Start Menu   

Click start button from the left of the task bar.   The   Start menu will appear. 

Place the mouse pointer on All Programs.    A Submenu   will appear to the right. 

Click on Internet   Explorer.  Internet   Explorer will open.  

Or click internet from pinned program are 
 
Using a Shortcut 

 First, locate the Internet Explorer shortcut. 

This is a blue, graphically styled "e" with Internet 

Explorer written beneath it. 

 Position the mouse over the "e" and double-click. 

 The Internet Explorer window will appear. 
 
The Explorer Window 
 As you start Internet Explorer, its main browser window opens. It offers 

a selection of different toolbars as shown below. 
 
Title Bar:  
 It shows the title of current Webpage.   It also tells you whether    you   

a r e connected to Internet or working offline. 
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Menu Bar:  
 It shows the main   menu   that gives you access to all Explorer's 

features. 
 
3.  Standard   buttons   : 
 This toolbar contains all the main features you n eed  t o  nav iga t e 

around the Web. 
 
Address Bar:  
 This is where you type the addresses of Web sites that you want to 

visit. 
 
Link Bar:  
 This toolbar provides a selection of links to Microsoft related Web 

sites. 
 
Main Browsing window:  
 This area is where the Web sites that you visit will be 

displayed. 
 
Go button:  
 After typing the address of Web sites, clicking   on this button will 

request the page to be displayed. 
 
Status Bar:  
 This bar has information relating to the activity being carried out. 

For example, "Done" indicates that a requested Web page has been 
transferred to your Web Browser, or if you click on a hyperlink the URL 
(Uniform Resource 
Locator) of that link will be displayed. 

 
Connectivity icon:  
When you are working online this icon is displayed. 
 Scroll Up or Down Arrow: Click on these buttons to move up or down 

the current Web pages. 
 
You can use Internet Explorer by using only the features of the Standard 
buttons toolbar. This toolbar comprises several graphically styled buttons. 
The buttons are, in fact, shortcuts to features that will help you find your 
way around the Web quickly. Once you have learnt what each of these 
symbols means you can save a lot of time instead of looking the features 
in the menu bar. 
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The Standard Toolbar 
1. Back: Takes you to the previous page you were on. 

2. Forward: Clicking on this button will display the page on screen on which 

you 

were working before using the Back button. 

3. Stop: Stops downloading a page from the Internet. 

4. Refresh: Refreshes the current page to show the latest version. 

5. Home:  Loads a default home page for internet explorer. 

6. Search: Opens the Search panel in the Explorer window. This gives you 

access to features that helps you connect to Search Engine. 

7.  Favourites: Opens the Favouri tes Panel in the Explorer window, which 

allows you to 

creating, access, and managing your favouri te si te on the web. Basically with 

favouri te button you can add and or organize your favouri tes websites 

8. Histor y: Opens the hi story panel to the lef t in the Explorer window.  

Thi s 

provides a list of Web si tes that you have previously visi ted when using 

Explore 

and by c licking one you can automatically connect to i t. 

9. Mail: Provides a menu of options related to e-mail.  These include 

reading mai ls,  sending new e-mai l message, sending li nks, sending 

pages & reading news.  
10. Print: Prints a curent page. 

11. Edit : Allows you to edit the code of the current Web page, either in text 

format 

or using a Web page editor such as FrontPage. Save any changes on your 

hard disk 

but they will not affect the Web page itself. 

 
Assignment for Lesson #2 ……………………………………. 

1. What do you know about web browsers? 
2. Mention the top three web browsers and their owners 
3. List the most five functional similarities of web browsers 
4. Draw web browser and briefly described the important parts 
5. Differentiate between WAN and LAN 
6. Differentiate between Server and Client 
7. Mention the most recent version of Internet Explorer 
8. What is the main function of the main windows in a web browser? 
9. List any five commands found in the Standard Toolbar 
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Lesson #3 Search Engines.  

 

What is the search engine? 

 This is an online program that help the user to search information like 

websi tes, images, video, audio, emai ls etc in the internet using keywords 

set by information owners 

 A software program that searches a database and gathers and reports 

information that contains or is related to specified terms (keywords).  

 A website whose primary function is providing a search engine for gathering 

and reporting information avai lable on the Internet or a portion of the 

Internet. 

 It uses keywords posted onto the relevant search engine 
 

Types of search engines: 

1. General Search Engines -- This is a collection of general-interest search 
engines, directories, meta search engines and child-safe search tools. eg. 
Google, yahoo, MSN, AltaVista, infoseek etc 

2. Specific Search engines 

a. These engines searches specialized things like: 

 Information about specific country like UK or Japan only etc.  

 Prices Search Engine 

 Video search engine 

 images 

 Audio 

 Software etc 

 

Popular search engines  

Examples of popular search engines are: 
Google 
Needs no introduction. Index of 3 billion. Google Rules! Google has become a 
standard world engine for its sensitive capability to retrieve the exactly result related 
to your keyword while at the same filtering the unwanted result that may confuse the 
client. Google grab automatic links from newly uploaded website making it possible 
to find anything you need in the net. Further more unlike other search engine, 
Google is limited with ads and if the appear, they are few and relevant to the 
information you are searching for. 

Yahoo Search 
Yahoo is the second largest world search engine after Google. Its popularity lies on 
free email usage all over the world. There is a recent bargaining from Microsoft to 
buy the company at around 46bn USD of which no agreement reached yet. 
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AltaVista 
Was once the best, went through a deep portal slump, and is back bigger and better 
into the Top 4 indexes. Now owned by Yahoo.  

Ask Jeeves 
Ask Jeeves lets you type a question in plain English and get back easy-to-
understand answers.  

Inktomi 
Used by MSN, Looksmart and Hotbot. Now owned by Yahoo. 

 HotBot 
Advanced search capabilities available.  
Lycos 
Advanced search capabilities available.  

Teoma.com 
New search engine with a clean interface 

Excite 
Uses GoTo.com 

Wisenut.com 
New search engine owned by LookSmart 

 FastSearch 
True to its name. 

iWon.com 
Search and win! 

MSN Search 
A search engine backed by Microsoft, powered by Inktomi, LookSmart and DirectHit  

AOL Search 
Backed by AOL, powered by ODP and Inktomi 

Mamma search engine 

www.mamma.com 

To search anything from the internet wri te a keyword that explain what do you 

really want. 

A Keyword is a word, phrase or sentences that identify the information you are 

looking for among many other information.  The longer the keyword the precise 

and fewer results you get. Even sometime longer keywords yield zero results. It 

is advised therefore to change keywords several times from longer one to 

shorter one until the results you are looking for are displayed.  

 

Example: Computer prices will search all information which includes either 

computer prices, prices or computer.  

“Computer prices” will only search for computer prices 
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Assignment for lesson #3 ………………………………. 

1. What is the search engine? 

2. Mention types of search engines 

3. List any five popular search engines  
 
Lesson #4 Navigating through the Web 

Navigating the web is just another term of exploring or surfing the internet. Visiting 

websites of choice for various needs, some can be; studying, downloading 

information or software, buying or selling, doing quotations,  chatting, reading and 

sending emails, attending lessons, forums or discussions, attending surveys, 

reading newspapers, or books, watching movies or music, listening music or 

speeches, playing games, doing reference for researches or various studies etc. 

 
Starting from the Address Bar 

In order to surf the internet effectively one should first understand about website 

addresses. 

The following is a brief description of website addresses, please follow the lesson 

attentively. 

Understanding Website Address  

A web address (sometimes called a URL, or Uniform Resource Locator) typically is 

composed of four parts: 

1. A protocol name (a protocol is a set of rules and standards that enable 

computers to exchange information)  

2. The location of the site 

3. The name of the organization that maintains the site  

4. A suffix that identifies the kind of organization it is (such as .com for a 

commercial organization)  

 

For example, the address http://www.infocomcenter.com/ provides the following 

information: 

http:// This Web server uses Hypertext Transfer Protocol (HTTP).  

www This site is on the World Wide Web. 

infocomcenter The Web server is at infocomcenter. 

com This is a commercial institution. 

 

Types of website by Extensions 
.com Widely used for commercial companies; eg. www.infocomcenter.com  
.net Widely used for network related institution; eg  www.webstar5.net  
.org Widely used for non profit organizations; eg. www.wvi.org   
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.edu Used for academic institutions; eg. www.stclements.edu  

.gov Used for governments institutions; eg. www.usa.gov  

.go.tz Used for governments institutions with specific country 

Examples are:  http://www.tanzania.go.tz  for Tanzania government institutions 
.co.tz Used for profit making institutions with specific country 

Examples are:  http://www.ttcl.co.tz  for Tanzania Telecommunication Company 

Limited 
.or.tz Used for non profit organizations with country specific extension 

Examples: www.wocha.or.tz   
.sc.tz Used for school institutions nursery, primary and secondary with country 

specific extension;  Examples: N/A 
.mil.tz Used for military institutions with country specific extension; Examples: N/A 

.ne.tz Used for network related institutions with country specific extension; eg.  N/A 

.ac.tz Used for tertiary academic institutions like colleges and universities with 

country specific extension; Examples are: http://www.esis.ac.tz  

 

The extension are emerging every day to reflect the new industry needs 

 

Typing URLs (Uniform Resource Locators) 

Click on the Address bar 

The URL that is currently in the Address bar will be selected. 

2.    Type the URL of the Web page you want to visit. The first URL will disappear 
and the URL you are typing will be displayed. 

3.      Press   the   Go button when you have finished typing the URL. The Web page 
will appear in the browser windows. 

Using Auto Complete/Drop lists to enter a URL 

If you've typed Web addresses previously in the Address bar, Internet Explorer will 
attempt to guess which Web address you want. In this case the address will 
automatically spell out and you have to press ‘ENTER’ command. The list of related 
addresses will also drop out. In this case this is called drop lists addresses. 

 
Assignment for lesson #4  

1. List other three word used for web navigation 

2. Describe the important parts of the URL 

3. Mention 10 web extensions and their types 
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Lesson #5  Storing Website Information  
 
There are three ways to store website information as follows: 
 

1. Save as normal file or document 
2. Use Copy command after selecting 
3. Use download command (if applicable) 

 
Save as normal file or document 
 
Go to file menu, select save as command then select your preferred destination. 
Remember to create a new folder and name according the information contained in 
your website 
 
Note: Some websites are protected from Save us command, hence you may end up 
with the response message ‘errors, the websites cannot be saved’ 
 
Use copy command 
 
This command is used after selecting the information or image which you want to copy 
 
Steps:   
 

 Select the desired information or image using the mouse 
 Right click it and select copy command 
 Go to the relevant application and select paste command by right clicking the 

area you want to put the information or image 
 If you want to copy an image either select as shown above or right click direct 

the image you want to copy and select copy command 
 Or right click an image and select save picture as command, follow onscreen 

instruction as save as command 
 
Note: Some websites are protected from copying command, hence you may end up 
with the response message ‘sorry. copy is not allowed in this website’ 
 
Downloading files from the internet 
 
There are two options 
 
Go to the website with downloadable file and: 

1. Select download link and click it to download (it may contain the word download 
or other instructive words). Sometime the file to be downloaded is located in the 
different location which may enquire you to click several links before reaching 
the file. 

2. Right click the downloadable file and select “save target as” 
In both option above the guiding wizard dialogue box will appear, follow the onscreen 
instructions 
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For both option, the following pop up dialogue box will appear: 
 

 
 
Use open command if you want to read the file once and discard, alternatively use the 
save command and select or create the folder in the computer or removable drive to 
save permanently your file for future use otherwise use cancel command to ignore the 
download option. 
 

 
 
Use run command if you want to install the application direct from the internet and 
discard the installation file, alternatively use the save command and select or create 
the folder in the computer or removable drive to save permanently your application file 
for future use otherwise use cancel command to ignore the download option. 
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Printing Web information 
 
Three steps are necessary for any computing printing. 
These are: 
 

1. Page setup 
2. Print preview 
3. Printing 

 
Page Setup 
 
We normally use page setup to set paper size, header and footers (optional), 
orientation and margins E.g. If you want to print a web document in an A4 paper, when 
in page setup select 
 
Paper size ‘A4’ 
 Paper source ‘auto feeder’ 
 Header ‘fill the appropriate information’ 
 Footer ‘fill the appropriate information’ 
 Paper orientation ‘select either portrait or landscape’ 
 Paper margins ‘set left, right, top and bottom paper margins’ 
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Print preview 
 
 We preview documents to be printed in order to see if: 
 The whole document match with the selected settings in page setup 
 The document match with printer settings 
 
Printing a document 
 
 In printing dialogue box: 
 Select printer to use from a varieties of printers (this depend on the quantity of 

installed printers in your computer) 
 Set printer preference 
 Set number of copies you want to print  
 Select all pages if you want to print all or type the page number you want to print in 

the space provided below eg.  9 or 1, 2, 6-13 or 1-10 etc 
 

 
 

Assignment for lesson 5…………………………………….. 
 

1. Describe important methods to save web information 
2. Describe important methods to download files in the internet 
3. What is the function of  

a. Print setup 
b. Print preview 
c. Printing a document 
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Lesson #6 Electronic Mails 

 
Course Contents 
 

1. Introduction 
2. Opening and closing the program 
3. Composing messages 
4. Formatting messages 
5. Spell checking messages 
6. Attaching and downloading attachments (files) 
7. Sending and receiving messages 
8. Saving messages 
9. Printing messages 

 
Introduction: 
 
Email is an abbreviation of Electronic mail, which means the communication of 
information (text, graphics and or attachment) through the networked computers ie. 
through the internet 
 
Understanding Emails Managers 
 
There are two types of email managers 
 

1. Internet based (Online programs or webmails) 
2. Local Based (ie Within your computer) 

 
Internet based 
 
Internet based email managers are programs that manage emails online or in the 
internet; example hotmail, google mail and yahoo mail. Online mails management is 
also known as webmails. 
 
Local Based 
 
Local based email management is the management of emails within the local 
computer; email messages can be composed locally just like writing using word. 
The messages can be downloaded  from the internet and saved in the local computer. 
The emails can also be uploaded to the internet leaving the copy in the computer 
 
Examples are; Eudora Express, Microsoft Outlook and Outlook Express 
 
Versions of Microsoft Outlook are expressed in years like Microsoft Outlook 97, 
Microsoft Outlook 2000, Microsoft Outlook 2002,  Microsoft Office Outlook 2003 and 
Microsoft Office Outlook 2007 
 
While those of Outlook Express are expressed in numeral like Outlook Express 5, 
Outlook Express 6 and Outlook Express 7 
 

Advantages and Disadvantages of each type 
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Internet Based Emails 
 
Advantages 

1. You can receive, read, compose and share your emails in any part of the globe 
even without travelling with your computer. Just go to the internet café or any 
internet connected computer and start your online service (ie webmail like 
yahoo, gmail, hotmail etc) 

2. Emails messages are more secure than if you decide to manage locally 
because email services providers like web hosting companies uses highly 
qualified technicians and high-tech equipment to maintain the servers, and 
protect information against computer hackers, viruses, spyware and online 
terrorists. 

 
Disadvantages 
 

1. Email cannot be accessed if there is no internet services 
2. They are much slower than the local based emails 

 
Local Based Emails 
 
 Advantages 

3. Email can be accessed even if there is no internet services and hence easier to 
make reference for old emails. 

4. They are much faster than the internet based emails  
5. Emails messages can be stored and transferred using removable media 

 
Disadvantages 
 

6. You cannot receive, read, compose and share your emails in any part of the 
globe apart from your place where the local computer is located (except if you 
are using online packages that can retain online copies). But due to remote 
management programs, it is easier to access your office computer while 
travelling 

 
7. Emails messages are not secure than online one because most local users 

cannot afford in budget and high tech to protect information against computer 
hackers, viruses, spyware and information terrorists. 

 
For the sake of this guide, we will limit ourselves to Google Mail and Outlook Express 
mails 
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Introduction to E-mail

1. Go to www.gmail.com

2. Click on “Sign Up for Gmail”

• E-mail allows you to communicate with people all over the world, for free! 

• This handout will help you sign up for a Gmail account and learn how to send, receive, and manage your e-mail 
messages.

How to sign up for a Gmail Account:

First, some general information about e-mail addresses:

• E-mail addresses are composed of two parts connected by the “at” symbol (@):  

• There are no spaces in an e-mail address.

• You may use a combination of letters and numbers in your user name.

• E-mail addresses are usually typed in all lower case letters.

him@yahoo.com

Your 
username

@ Your e-mail 
provider
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3. Enter your first and last name.

4. Choose a login name.

• This will be the 1s t part of e-mail address.

• Choose something simple, that is easy to 

remember and spell.

• Use letters, numbers, or punctuation marks.

5. Click “check availability!”

• If this login name is not available, choose 
from the suggested list, or type a new one.

6. Choose a password.

• Choose something you can remember, 
but is not easy for others to guess.

• Use letters and numbers or special 

characters (ex. Pet$52name).

7. Choose a security question 
from the drop-down menu.

• If you forget your password, Gmail will 
ask you this question. Don’t forget your 

ans wer!

8. Type your answer to the 
security question.
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9. Leave “secondary email” blank.

10. Location: United States

11. Type the scrambled word in the box.

• This is a security feature to protect Gmail from 
programs that automatic ally sign up for email accounts.

• For example, here you would type floon.

12. Read the Terms of Service.

13. Click “I accept. Create my account.”

Congratulations! You have signed up for an e-mail account!

Your e-mail address is “your_login_name@gmail.com”

Write it here: __________________________@gmail.com
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How to use your Gmail account:

1. Go to www.gmail.com

2. Enter your username and password.

•Your password will show up as **asterisks**  This is a security feature.

•Do not click “R emember me on this computer” if you are using a public 

computer (like at the library).

3. Click “Sign in”

Your mail 
(new messages will be in bold)

Sender’s name Subject of the message

(If you forget your username or password, click “I cannot access my account.”)
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How to read your messages:

1. Click on the name of the sender or the subject of the message.

Message subject

Sender’s name and 

email address.

Body of the message.

2. You will see:

3. After you have read 
the message, you can:

• reply to it

• forward it to another person

• or leave it as is.

4. Once you are finished, click “Inbox” or “Back to Inbox” to see the rest of your messages.
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How to send a new message:

1. Click “Compose Mail.”

2. Enter the recipient's 
email address.

• type the whole address 
(ex. johndoe24@yahoo.com)

3. Enter a subject for the 
message.

• The subject should be short, 
but descriptive.

• If the subject is too generic 
(ex. “hi” or “how are you?”), 
the rec ipient may think it is junk 

mail (“spam”) and ignore it.

4. Type your message.

5. Click “Send.”

 
 
Slide 7 
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How to Open an Attachment:
Pictures, reports, resumes, etc. are often sent as “attachments.” This means they are not written in the 

body of the email message, but are separate files that must be opened to be viewed or read.

Attachments are identified by a small paperclip icon next to the email message’s information.

The attachment will appear after the body of the message.  
The file extension (here: .doc) tells you what kind of document it is (.doc = Word 
document; .jpg or .gif = picture; etc.).

To open the attachment:

Click on:

“View as HTML” just to look at it 
in your Internet Browser.

or

“Download” to save it to your 
computer. 

Warning:

Viruses are often sent as email 

attachments. Gmail will scan the 
attachment for viruses, but…

Do not open any attachments with a .exe file extension or if you do not know the sender or are not 

expecting the attachment. It is better to be safe than sorry!
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How to send an attachment:

1. Click “Compose 
Mail.”

2. Enter the email 
address and subject 
and click “Attach 
file.”

3. Click “Browse” to 
find your file.

4. In the box that opens, use the Look in: 
drop-down menu to find the location of 
your file.

5. Select the file.

6. Click “Open.”

7. Finish writing your email message and 
send it.
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More Gmail tips:

1. Search Mail

• Use this box to search for names, words, or phrases within your email messages.

• It will show you all the messages you have sent and received with those keywords anywhere 
in the message.

2. Contacts

• To add an email address to your Contacts list, open a message from that person.

• Clic k the drop-down menu next to Reply.

• Clic k “Add sender’s name to Contacts list”

Remember: always Sign Out of your email when you are finished!
This is especially important when you are using a public computer (like at the library).

 

Local based emails 
 
Understanding Outlook Express 
 
Microsoft Outlook Express puts the world of online communication on your desktop. 
Whether you want to exchange e-mail with colleagues and friends or join newsgroups 
to trade ideas and information, the tools you need are here. 
 

With an Internet connection and Outlook Express, you can exchange e-mail messages 
with anyone on the Internet and join any number of newsgroups. 

The Internet Connection Wizard helps you connect to one or more e-mail or news 
servers. You will need the following information from your Internet service provider 
(ISP) or local area network (LAN) administrator: 

 To add an e-mail account, you need your account name and password, and the 
names of your incoming and outgoing e-mail servers.  

 To add a newsgroup, you need the name of the news server you want to 
connect to and, if required, your account name and password.  
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The following topics tell you how to start receiving and sending e-mail, in addition to 
how to view and join newsgroups. After you get started, you'll find there are many ways 
to tailor Outlook Express to your needs. Look in Help Contents for ideas. 

 

h  
 
 
Opening and Closing the program:  Go to the Start menu then click Email in the 
pined program area or open all programs and click outlook express shortcut 
 

Assignment for lesson #6 
1. What do you know a bout email 
2. Mention and describe two types of email managers 
3. What are the advantages and disadvantages of each type  
4. What are the main parts of an email address and meaning 
5. What is the basic information needed to register an email address? 
6. What is the basic information needed to login to an email address? 
7. Describe the basic features (functions) of the email manager 
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Lesson 7:  Basic Outlook Express setup 

To add an e-mail account 

You will need the following information from your Internet service provider (ISP) or local 
area network (LAN) administrator: 

1. For e-mail accounts, you'll need to know the type of e-mail server you use 
(POP3, IMAP, or HTTP), your account name and password, the name of the 
incoming e-mail server and, for POP3 and IMAP, the name of an outgoing e-mail 
server.  

2. On the Tools menu, click Accounts.  

3. In the Internet Accounts dialog box, click Add.  

4. Select either Mail or News to open the Internet Connection Wizard, and then 
follow the instructions to establish a connection with an e-mail or news server.  

Note 

Each user can create multiple e-mail or newsgroup accounts by repeating the 
procedure above for each account.  

To switch between e-mail and news reading 

In the Folders list, click the Inbox folder to go to your e-mail, or click a news server 
name or specific newsgroup to visit newsgroups.  

-or- 

Click Outlook Express at the top of the Folders list to open the Outlook Express pane 
where you can click a link for the task you want. 

Setting up multiple identities 

If there is more than one person in your house using the same computer for e-mail, 
each person can have a separate mailbox in Outlook Express. This means that each 
person can have separate messages, contacts, and personal settings. This is made 
possible through the creation of multiple identities. Once the identities are created, you 
can switch among them without having to shut down your computer or lose your 
Internet connection. 

The following topics provide more information: 

1. Add a new identity 

2. Delete an identity 

3. Switch to a different identity 

4. Change the current identity's settings 

5. To add a new identity 

On the File menu, point to Identities, and then click Add New Identity.  
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1. Type the name of the new user.  

2. If you want to include a password for this identity, select the Require a 
password option, and then enter a password.  

Outlook Express asks you if you want to log on as the new user. If you answer 
yes, you will be prompted for information about your Internet connection. If you 
answer no, the current user remains logged on. 

To delete an identity 

1. On the File menu, point to Identities, and then click Manage Identities.  

2. Select a user, and then click Remove.  

Notes 

 You cannot delete the current identity.  

 When you delete an identity, the corresponding settings are deleted, but the data 
are not deleted.  

To switch to a different identity 

1. On the File menu, click Switch Identity.  

2. Select the user you want to switch to.  

To change the current identity's settings 

1. On the File menu, point to Identities, and then click Manage Identities.  

2. Change any of the settings.  

o To change your identity name or password, select your identity name, and 
then click Properties.  

o To change the identity that opens on startup, select an identity from the 
drop-down list. (If the check box is cleared, you will be prompted for the 
identity you want each time you open an identity-aware program.)  

o To change the identity that you want all programs (identity-aware or not) 
to use when performing automatic processes, select an identity from the 
bottom drop-down list.  

Customizing the Outlook Express window 

There are a number of ways to arrange the Outlook Express window to suit your 
working style: 

1. Change the display of the preview pane 

2. Change the Outlook Express Folders list, status bar, or toolbars 

3. Customize the toolbar 
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4. Change the columns displayed in the message list 

5. Change the font used to display messages 

To change the display of the preview pane 

The preview pane lets you view message contents without opening the message in 
another window. To preview a message, click its title once. To open it in its own 
window, double-click the title. 

You can position the preview pane either below the message list or beside it; you can 
choose to display or hide the message header; or you can hide the preview pane 
entirely. 

1. On the View menu, click Layout.  

2. In the Preview Pane area, select the options you want and then click OK.  

Note 

 To resize the preview pane and the message list, point to the divider between 
them until you see a double arrow, and then drag the divider up or down.  

To change the Outlook Express folder list, status bar, or toolbars 

 To hide or display the Folders list, Contacts list, Outlook bar, status bar, or 
toolbars, on the View menu, click Layout, and then select the options you want.  

 To display subfolders in the Folders list, double-click the plus sign (+) to the left 
of each of the main items in the Folders list (Local Folders, your e-mail server, 
news servers, and so on). All of the subfolders appear beneath their main folder 
or server, and the plus sign becomes a minus sign.  

If you click the main folder name instead of its plus sign, the subfolders display in 
the main Outlook Express window, rather than beneath the folder or server in the 
Folders list.  

 To display the Outlook Express start-up window, which contains links to primary 
Outlook Express tasks, as well as a Tip of the Day, click Outlook Express at the 
top of the Folders list.  

To customize the toolbar 

1. If you are in the main window, on the View menu, click Layout, and then click 
Customize Toolbar.  

If you are in a message window, on the View menu, point to Toolbars, and then 
click Customize. 

2. To modify the toolbar text, select an item from the Text Options list.  

3. To modify the icon size, select an item from the Icon Options list.  

4. To add or remove buttons, click the button name in the Available toolbar 
buttons list, and then click Add or Remove.  
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To change the order in which buttons appear, click the button in the Current 
toolbar buttons list, and then click Move Up or Move Down.  

To change the columns displayed in the message list 

1. On the View menu, click Columns.  

2. To add a column, select the check box next to the column name, or select the 
column name and click Show.  

To remove a column, clear the check box next to the column name, or select the 
column name and click Hide. 

To change the order in which columns appear, select a column name, and then 
click Move Up or Move Down. 

To change the font used to display messages 

1. On the Tools menu, click Options, and then click the Read tab.  

2. Click Fonts, and then change the settings.  

 
Managing address book 

The Address Book provides a convenient place to store contact information for easy 
retrieval by programs such as Microsoft Outlook Express. It also features access to 
Internet directory services, which you can use to look up people and businesses on the 
Internet. You'll find that the following features help you organize all your contact 
information into the most usable form for you.  

Store important information about the people and groups who are important to 
you 

With your Address Book, you have a place to store e-mail addresses, home and work 
addresses, phone and fax numbers, digital IDs, conferencing information, instant 
messaging addresses, and personal information such as birthdays or anniversaries. 
You can also store individual and business Internet addresses, and link directly to them 
from your Address Book. For extra information that doesn't fit in these categories, 
there's a generous section for notes. 

Find people and businesses by using Internet directory services  

Directory services are powerful search tools that enable you to look up names and 
addresses on the Internet. The Address Book supports Lightweight Directory Access 
Protocol (LDAP) for using Internet directory services. 

Create groups of contacts for mailing lists 

You can create groups of contacts to make it easy to send e-mail to a set of people, 
such as business associates, relatives, or friends. Any time you want to send e-mail to 
everyone in the group, just use the group name instead of entering each contact 
individually. Creating groups is also a good way to organize a large Address Book. 

Share your Address Book with other users 
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By creating an identity for every person who uses the Address Book, each user can 
organize contacts into his own folder. In addition, each user can put contacts into a 
Shared Contacts folder so that other identities can use them. 

Import names from your other address books 

Moving forward with Outlook Express doesn't mean leaving your old address book 
information behind. You can import your personal address books from numerous 
popular e-mail programs including Microsoft Exchange, Eudora Light and Eudora Pro, 
Netscape Communicator, Microsoft Internet Mail for Windows 3.1, and any program 
that exports text files with comma-separated values (CSV). 

You can also use your address book files with either Microsoft Exchange or any other 
program that imports files in CSV format. 

Send and receive business cards 

Business cards are the new way to send contact information electronically. When you 
create a business card in the Address Book, your contact information is stored in vCard 
format, so it can be exchanged between different programs (such as e-mail, address 
books, and personal planners), and between different digital devices (such as desktop 
computers, laptops or portable computers, personal digital assistants, and telephony 
equipment).  

Print all or part of your Address Book and take it with you 

Now you can print your Address Book to add to your personal planner. With three page 
styles to choose from, you can print all contact information, only business information, 
or only phone numbers, for any or all contacts.  

To open the Address Book 

 To open the Address Book from Outlook Express, click Addresses on the 
toolbar, or on the Tools menu, select Address Book.  

 To open the Address Book from within a message window, click the To, Cc, or 
Bcc icon.  

Note 

 To use the Address Book directory services from the Windows Start menu, click 
Start, click Search, and then click the option for finding people.  

Adding contacts to your Address Book 

There are several ways to add e-mail addresses and other contact information to your 
Address Book: 

Add names directly from e-mail messages 

Import an address book from another program 

Type names and contact information directly in to your Address Book 
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Add people and businesses you find on the Internet 

Import a business card (vCard) 

To add names directly from e-mail messages to your Address Book 

You can set up Outlook Express so that when you reply to a message, the people you 
reply to are automatically added to your Address Book. In addition, any time you send 
or receive a message in Outlook Express, you can add the recipient's or sender's name 
to your Address Book. 

To add all reply recipients to your Address Book 

1. In Outlook Express, on the Tools menu, click Options.  

2. On the Send tab, click Automatically put people I reply to in my Address 
Book.  

To add an individual name to your Address Book from Outlook Express 

 In a message you are viewing or replying to, right-click the person's name, and 
then click Add to Address Book.  

 In the message list of your Inbox or other mail folder, right-click a message, and 
then click Add Sender to Address Book 

To import an address book from another program 

You can import address book contacts from other Windows Address Book files (.wab), 
as well as from Netscape Communicator, Microsoft Exchange Personal Address Book, 
or any text (.csv) file.  

For Windows Address Book files: 

1. In Address Book, on the File menu, point to Import, and then click Address 
Book (WAB).  

2. Locate and select the address book you want to import, and then click Open.  

For all other address book formats: 

1. In the Address Book, on the File menu, point to Import, and then click Other 
Address Book.  

2. Click the address book or file type you want to import, and then click Import.  

If your address book is not listed, you can export it to either a text (.csv) file or an 
LDIF (LDAP Directory Interchange Format) file, and then import it using that file 
type. 

To add a contact to your Address Book 

1. On the Outlook Express toolbar, click Tools, and then click Address Book.  

2. In the Address Book, select the folder to which you want to add a contact.  
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3. On the Address Book toolbar, click New, and then click New Contact.  

4. On the Name tab, type at least the first and last name of the contact. This is the 
display name.  

A display name is required for each contact. If you enter a first, middle, or last 
name, it will automatically appear in the Display box. You can change the 
display name by typing in a different name or by selecting from the drop-down 
list. The drop-down list will contain variations of the first, middle, and last name, 
as well as anything you typed in the Nickname box or the Company box on the 
Business tab. 

5. On each of the other tabs, add any information you would like to include.  

Notes 

 Be sure to include an e-mail address for your contact. While your Address Book 
can be used for many purposes, its most immediate benefit is in providing e-mail 
addresses when you are composing mail.  

 If you include a contact's street address on the Home tab or the Business tab, 
you can click View Map located on each of these tabs to display a printable 
street map showing the contact's address.  

To find people and businesses on the Internet 

1. In the Address Book, click Find People on the toolbar.  

2. From the Look in drop-down list, select the directory you want to search.  

3. On the People tab, type the name or e-mail address of the person you want to 
look for, and then click Find Now.  

-or- 

On the Advanced tab, define the search criteria you want by filling in the top 
three boxes, and then click Add. Add all the search criteria you want, and then 
click Find Now. (To remove a search criterion you added, select the item you 
want to delete from the Define Criteria list, and then click Remove. Or, if you 
want to delete all criteria and start over, click Clear All.) 

Notes 

 Your search will be most efficient if you use starts with or is. The options for 
contains, ends with, or sounds like can make your search take much longer, 
possibly so long that the search fails. The more exact your search criteria, the 
faster the result.  

 If your search is too broad, the number of matches might exceed the limits of the 
server, or your directory service settings might not be set up to handle all of the 
returned matches. You can change these directory service settings.  

To import a business card 
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1. In the Address Book, on the File menu, point to Import, and then click Business 
Card (vCard).  

2. Locate the business card file on your computer or a network drive, select it, and 
then click Open.  

Note 

 When the business card is added to your Address Book, a dialog box appears 
where you can modify or add to the contact information as necessary.  

 Once the contact's street address is entered on the Business tab, you can click 
the tab's View Map button to display a map pinpointing the address. When you 
click View Maps, Expedia Maps opens in your browser with a printable street 
map showing the contact's address 

To change contact information  

 In the Address Book list, locate and double-click the name you want, and then 
change the information as needed. Click the tabs to access different information 
sections.  

Note 

 To delete a contact, select the contact name in the Address Book list, and then 
click Delete on the toolbar. If the contact is a member of a group, the name will 
also be removed from the group.  

To create a group of contacts 

You can create a single group name (or alias) to use when sending a message to 
several contacts at once. Simply create a group name and add individual contacts to 
the group. Then, just type the group name in the To box when you send e-mail.  

1. In the Address Book, select the folder in which you want to create a group. Click 
New on the toolbar, and then click New Group.  

2. The Properties dialog box opens. In the Group Name box, type the name of the 
group.  

3. There are several ways to add people to the group:  

o To add a person from your Address Book list, click Select Members, and 
then click a name from the Address Book list.  

o To add a person directly to the group without adding the name to your 
Address Book, type the person's name and e-mail address in the lower 
half of the Properties dialog box, and then click Add.  

o To add a person to both the group and your Address Book, click New 
Contact and fill in the appropriate information.  
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o To use a directory service, click Select Members, and then click Find. 
Select a directory service from the drop-down list at the end of the text 
box.  
After finding and selecting an address, it is automatically added to your 
Address Book.  

4. Repeat for each addition until your group is defined.  

Note 

 To view a list of your groups separately from the Address Book listings, in the 
Address Book, on the View menu, make sure that Folders and Groups is 
selected.  

 You can create multiple groups, and contacts can belong to more than one 
group.  

To add a contact to an existing group  

1. In the Address Book list, double-click the group you want. The group's 
Properties dialog box opens.  

2. You can add people to the group in several ways —and in some cases you can 
add them to your Address Book as well.  

o To add a person from your Address Book list, click Select Members, and 
then click a name from the Address Book list. Click Select, and then click 
OK.  

o To use a directory service (use the drop-down list at the end of the text 
box to see directories you have added to Outlook Express), click Select 
Members, and then click Find. Select a directory service to search, enter 
your search criteria, and when you find the person, click Select, and then 
click OK.  
This person's name and e-mail address is added to your Address Book.  

o To add a person directly to the group without adding the name to your 
Address Book, type the person's name and e-mail address in the boxes 
provided in the lower half of the dialog box, and then click Add.  

o To add a person to both the group and your Address Book, click New 
Contact, fill in the appropriate information, and click OK.  

To create a business card 

The easiest way to exchange contact information with people over the Internet is by 
attaching a business card to e-mail messages. A business card is your contact 
information from the Address Book in vCard format. The vCard format can be used with 
a wide variety of digital devices and operating systems. 

You must have your contact information in your Address Book before you can create a 
business card. 
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1. In the Address Book, create an entry for yourself, and then select your name 
from the Address Book list.  

2. On the File menu, point to Export, and then click Business Card (vCard).  

3. Select a location in which to store the file, and then click Save.  

Note 

 To add your business card to an e-mail message, on the Insert menu, click My 
Business Card.  

To import an address book from another program 

You can import address book contacts from other Windows Address Book files (.wab), 
as well as from Netscape Communicator, Microsoft Exchange Personal Address Book, 
or any text (.csv) file.  

For Windows Address Book files: 

1. In Address Book, on the File menu, point to Import, and then click Address 
Book (WAB).  

2. Locate and select the address book you want to import, and then click Open.  

For all other address book formats: 

1. In the Address Book, on the File menu, point to Import, and then click Other 
Address Book.  

2. Click the address book or file type you want to import, and then click Import.  

If your address book is not listed, you can export it to either a text (.csv) file or an 
LDIF (LDAP Directory Interchange Format) file, and then import it using that file 
type. 

To export your Address Book contacts to other programs 

You can export your Address Book contacts to other Windows Address Book (.wab) 
files, as well as to Microsoft Exchange Personal Address Book, or any text (.csv) file.  

To export your Address Book files to another Windows Address Book: 

1. In Address Book, on the File menu, point to Export, and then click Address 
Book (WAB).  

2. Locate and select the Windows Address Book file you want to export to, and 
then click Open.  

For all other address book formats: 

1. In the Address Book, on the File menu, point to Export, and then click Other 
Address Book.  

2. Click the address book or file type you want to export to, and then click Export.  
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Assignment for lesson 7 

1. What are the steps needed to install an email account to outlook express? 
2. What is address book? 
3. Create five contacts groups and enter five contacts in each group 

1. Friends,  
2. Business,  
3. Family members, 
4. Customers,  
5. Suppliers 

4. What are the steps to send and receive business cards 
5. How to print all or part of your address book? 
6. How to import and export e cards? 

 

Lesson #8 Dealing with email messages 
 

1. Import messages from other e-mail programs 
2. Create new message 
3. Formatting message text 

a. Use HTML formatting 
b. Change the font, style, or size of text 
c. Format a paragraph 
d. Create a numbered or bulleted list 

4. Using stationary 
5. Inserting an item into an e-mail message 

a. Add a signature to outgoing messages 
b. Insert a file into a message 
c. Insert a business card into all messages 
d. Include a sound in a message 
e. Insert a picture into a message 
f. Insert a hyperlink or HTML page into a message 

6. Read your messages 
a. Managing e-mail messages with rules 

When you have large volumes of incoming e-mail, Outlook Express can help you 
process it more efficiently. You can use rules in Outlook Express to automatically sort 
incoming messages into different folders, highlight certain messages in color, 
automatically reply to or forward certain messages, and do much more. 

b. The following topics provide more information: 
c. Create a rule for e-mail messages 
d. Change a rule 
e. Apply a rule to downloaded messages 

7. Dealing Instant Messaging (IM) 
a. Sending IM 
b. Managing online IM 
c. Storing IM information 

To import messages from other e-mail programs 

Using the Outlook Express Import Wizard, you can easily import e-mail messages from 
a variety of popular Internet e-mail programs such as Netscape Communicator and 
Eudora, as well as from Microsoft Exchange and Microsoft Outlook. 
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1. On the File menu, point to Import, and then click Messages.  

2. Select the e-mail program you want to import messages from, and then click 
Next.  

3. Verify the location of your messages, and then click Next.  

4. Choose All folders to import all the messages, and then click Next. You can 
also choose Selected Folders to import messages from one or more folders.  

5. Click Finish.  

Note 

 If you are unsure which e-mail program and version you want to import 
messages from, start the e-mail program. On the Help menu, select About and 
check the information.  

 
 
Composing messages:  
 
Click Create Mail or go to file menu then select new followed by Mail Message 
 
The New Mail Message Workspace Components 

1. To: 
2. cc: 
3. Subject: 
4. Message area 
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To: This is an area to write or paste your recipient email address 
Email address are normally written in small cases without spaces 
Multiple addresses are separated by coma followed by one space 
 
The Same Applied to: Cc and Bcc Options 
 
Cc: is an abbreviation of Carbon Copy  
This an option used to send copies to others recipients apart from the targeted who 
are send through ‘to’ command. 
 
Bcc: is an abbreviation of Blind Carbon Copy  
This is an option used to send hidden copies that the other recipients will not be aware 
of 
 
Subject:  This is a place where you can put or paste the summary of your 
message. The subject message is recommended to be in Title Cases, CAPITAL CASE 
imply brutal language in many readers view 
 
The Messages: This is a place where you can write or paste your message; you 
can also spell check and format your message as you want 
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Formatting the message:There are 16 formatting commands to use 
Paragraph style, bold, italic, underline, font colour, numbering, bulleting, left indent, 
right indent, left alignment, centre alignment, right alignment, justify, insert horizontal 
line, insert hyperlink and insert picture.   
 
To use the option above select the text or paragraph and click the command, for 
inserting line and picture put the cursor to the place you want to insert the item 

 
Spell Checking 
 
It is recommended to spell check your message even if it looks like correctly spelled.  If 
it is correctly spelled, it will show you a ‘The spell check is complete’ pop up message 
 
To spell check go to the tool menu then select spelling command or click direct from 
the standard toolbar 
 
Attaching documents: 
 
To attach a document go to insert menu then select file attachment command or click 
direct the worn attach from standard tool bar.  The dialogue box will pop up, follow 
onscreen instruction ie go to the folder where your file is located then open it then click 
attach 
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Delete an attachment 
 
To delete an attachment just click it and strike the delete button in the key board or 
right click it and select remove command or click delete from the standard butons 
 
Inserting photos 
 
To insert a picture or photos select the place where you want to put the picture then go 
to insert menu and click picture or click direct to the formatting bar and click the picture 
insert icon at the right of the bar. Follow again steps like those of attaching files. 
 

Assignment for lesson 8 …………………………………… 
 

1. What is IM? 
2. How to send IM? 
3. How to store IM Information to your computer? 
4. How to access stored information for your IM? 
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Lesson #9:  Sending and Receiving messages 
 
Sending messages 
 
After completing the steps of writing addresses, subject and message, formatting, 
spelling attaching and inserting files then you will need now to send your message. 
 
Procedures 

1. Countercheck again the correctness of your recipient email addresses, 
because wrong addresses normally cause the message undelivered 

 
2. If you are OK with addresses then go to file menu then and click send 

command or in the standard toolbar click the send command in the left 
 

 
NB:  When the send command is clicked the message is first sent to the outbox and 
the new message editor will disappear 
 
Sending and Receiving messages 
 
When the send command is clicked in the new message editor the message is not 
sent direct to the recipient addresses, but rather it is placed in the outbox folder. 
 
If you email program is configured to send automatically then the message will be sent 
immediately after being placed in outbox. But if it is manually configured then you will 
be supposed to do the following: 
 
Click  

1. Send And  Receive All  
Outlook Express will send first all messages in the outbox then it will 
receive all messages from the server and save it in the inbox 

2. Send All 
Outlook Express will send all messages in the outbox only 

3. Receive All 
Outlook Express will receive all messages from the server and save it 
in the inbox only 

 
Saving messages 
To save a message just go to file menu then click: 
 

1. Save (will save message in a draft folder) 
2. Save As (will save message in other folder as you will choose, just like 

saving document in MS Word) 
 
Reading Messages 
 
 All received messages will be save by default in the Inbox folder,  
 To quick read the message, it will be displayed in the small window below the 

message list area.   
 To read the message just double click it.   
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 Normally a read message window will be opened.  
 You can save the received message in other folders just follow instructions like 

those of saving messages in MS word 

 
Finding Message 
 
Go to edit menu and click find or click find from standard toolbar,  
 
In order to find a message you have to know a little bit about the message like: 

1. Location 
2. Sender Address 
3. Recipient Address 
4. Any Subject words 
5. Any Message text 
6. Date received before 
7. Date received after 

 
If you are through with the above option then click find now 
You have an option to stop the finding process, just click stop button 
 

Printing Email Messages 
 
You should be first in the read mail window. 
 To go to read mail window, select the email message you want to print and then 

double click it, in the read mail windows, 
 Go to file menu select Print command 
 The dialogue box will appear 
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You have three basic options to do before printing your document 

1. Select  the printer from printer list by click the correct printer driver 
2. Go to printer preference and set all required printer settings 
3. Set page range to print, 

a. If you want to print all select all 
b. If you want to print only one, ranges or multiple pages select pages and 

in the space provided input number according to the pages you want to 
print eg 1, 3, 5-12 etc 

 
1. Resent the letter written in Q3 assignment 6 with your CV attachment.  

Address the letter to the managing Director. Use infocom@habari.co.tz 
2. Receive the document and read the attachment  
3. Delete the attachment after reading 
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Assignment for lesson #9……………………………………. 
 
Mention basic procedure to send a message 
What is the function of these commands? 

1. Send all 
2. Receive all 
3. Send and receive all 
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Appendix 1. Glossary 

 
Internet Concepts: 
 

 Transmission Control Protocol/Internet Protocol (TCP/IP) 
 
 A set of networking protocols widely used on the Internet that provides 

communications across interconnected networks of computers with diverse 
hardware architectures and various operating systems. TCP/IP includes 
standards for how computers communicate and conventions for connecting 
networks and routing traffic. 

 Internet Protocol (IP)  

 A routable protocol in the TCP/IP protocol suite that is responsible for IP 
addressing, routing, and the fragmentation and reassembly of IP packets. 

 Protocol 

 A set of rules and conventions for sending information over a network. These 
rules govern the content, format, timing, sequencing, and error control of 
messages exchanged among network devices. 

 Packet 

 An Open Systems Interconnection (OSI) network layer transmission unit that 
consists of binary information representing both data and a header containing an 
identification number, source and destination addresses, and error-control data. 

 
 UDP 
 
 While UDP stands for User Datagram Protocol 

 Datagram 

 One packet, or unit, of information that includes relevant delivery information, 
such as the destination address, that is sent through a packet-switching network. 

 The connection is often through coaxial cable (coax), the same sort of stuff that's 
used for TV antenna signals, but it doesn't have to be. Network connections can 
be made by radio, infra-red light, carrier pigeon, you name it. Nowadays it's more 
common to see UTP (unshielded twisted pair) wiring, which is "star shaped" from 
a central hub out to each system; and the hubs talk with each other over fiber-
optic cable.  

 A network connection is shared by every computer on the same Local Area Net 
(LAN). They can all hear each other; imagine a bunch of people standing in a 
small room together.  
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 Only one network host (computer) on a LAN can talk at a time and be 
understood, unless the arrangement is something like UTP, where the hub can 
route traffic just between the interested parties.  

 A networked computer talks by sending a packet of data (a series of bits/bytes) 
addressed to either one other computer, (normal TCP/IP) or to everyone on the 
LAN who's listening (often UDP/IP).  

 Everyone on the LAN takes turns talking. On coax, if two computers start to talk 
at the same time, there's a protocol for deciding who gets to talk when. You can 
imagine a bunch of people in a discussion group, except most of the time they're 
talking to just one other person and the rest of the people aren't listening (until 
their name is called). On UTP, any pair of people can whisper to each other 
without bothering others in the room who are doing the same thing.  

Hardware addresses: 

 Every networked computer has at least one LAN interface (card) that contains a 
world-wide unique hardware address set by the manufacturer (48 bits = 6 bytes 
long). They look like this: 080009352D52.  

 You can think of hardware addresses as being like the numbers on the wires that 
leave the local phone company to go to your home telephone. You don't usually 
deal with them, but they are necessary to route your calls.  

 Hardware addresses are assigned to manufacturers in blocks of numbers at a 
time.  

 A network interface's hardware (station) address is only known to the other 
computers on the local network.  

 Two computers talking on a local network actually address each other by 
hardware address.  

Gateways: 

 Local networks are connected by gateways, which are either general-purpose or 
dedicated computers that are connected to two or more different LANs or WANs 
(wide area networks). They know which data packets should be forwarded from 
one network to another. Imagine two groups of people in two adjacent rooms, 
with one person at the common door who passes messages between the rooms. 
Separate conversations can take place in each room at the same time, but 
messages can also be relayed between the rooms.  

IP addresses: 

 Every LAN interface is assigned a world-wide unique IP address (32 bits = 4 
bytes). You can think of this address as the interface's "phone number". IP 
addresses look like this: 15.1.50.9.  
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 IP addresses are assigned to companies as blocks of subnet addresses. For 
example, HP owns net 15, and also some parts of net 192 such as 192.6.40.  

 Since a computer can have more than one LAN interface, it can have more than 
one IP address (phone number) -- just like your house.  

Hostnames and routes: 

 We associate "hostnames" with IP addresses, just like we associate human or 
business names with phone numbers. (See below about domain names.)  

 Since a computer can have more than one LAN interface and IP address, it can 
have more than one hostname, just like people can be addressed in different 
ways, depending on their roles and relationships. However, each LAN interface 
does not necessarily have a different name, because that could be confusing.  

 When a client computer connects to a server computer, it looks up the server's 
domain name in a directory through a nameserver (see below) to find the server 
computer's IP address, and then figures out a route to that address by using 
routing services on the same system or on other systems, including a gateway.  

 A simple form of a route is: "To reach any machine not on the local net, go 
through the gateway at 15.1.50.1." The client addresses a data packet to that 
gateway (using the gateway's hardware address). The gateway in turn figures 
out how to send the packet one step closer to the intended destination on a 
different LAN.  

 When a connection request (data packet) reaches a gateway on the same LAN 
as the target server, the gateway talks to the server using the server's hardware 
address, since it knows that number. (If it doesn't, it can use ARP (address 
resolution protocol) to find out, kind of like a waiter in a restaurant announcing, 
"phone call for Mr. Liu.")  

 
Port Numbers: 

 Once a client computer reaches (connects to) a server over the network, it needs 
a way to tell the server which service (server program) it wants to talk with. It 
does this by specifying a port number (at least in TCP/IP). You can think of port 
numbers as telephone extensions. Every call to a server system reaches an 
"operator" who asks for an extension number to put the call through.  

 On a server, when each server program starts running, it attaches to one or 
more port numbers and receives traffic on those ports.  

 On a client, when a service is needed, the client program looks up the standard 
port number for the service before connecting to the server system. It's also 
possible for a human talking with the client system to specify the port number to 
use for a given connection. For example, you can "telnet" to a server's email or 
HTTP port and do useful things, since those services speak ASCII (not binary).  
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 Obviously there is a lot of agreement in the world about standard port numbers, 
or clients would never be able to find their servers! But in fact any server 
computer can attach any server programs it likes to any port numbers.  

 
Protocols: 

 Just like in real life, a computer protocol is a formal description of how to talk to 
(or interact with) someone else.  

 TCP/IP stands for "transmission control protocol / internet protocol". Along with 
other protocols, it describes the way that virtual connections are made over 
networks, including hardware addresses, IP addresses, hostnames, etc.  

 Once a connection is made between a client and a server, how they talk with 
each other is described by a service protocol. For example, FTP (file transfer 
protocol) is a simple language for asking a server to get and send back to the 
client all the bytes in a specified file.  

 As you can see, to carry on a conversation, a whole stack of protocols happens 
at the same time. It's just like if you make a phone call to a business. There's a 
protocol you don't know about (because you can ignore it) that says how to build 
and wire up telephones. There's a higher level protocol (that you do know) about 
how to dial phone numbers. And once you get through, there is an even higher 
level protocol for how you might make a reservation or leave a message for 
someone.  

 When you call someone on the phone, you're talking to a human (or to an 
answering machine that will be heard by a human). Humans are pretty flexible 
and interactive, so you don't have to be real precise about protocols. But 
computer services are not so smart, so you must know and obey the protocols to 
talk with them.  

 
Domain Names: 

 Domains are a way of dividing up the world of computers so each one can have 
a unique name (that includes its location in the network) that's easy for people to 
use because it's made of words, not numbers.  

 Each domain can contain (know about) subdomains or individual computers.  

 A computer's full domain name starts with its hostname and ends with its top 
level domain. For example: "ajs.fc.hp.com" is a computer ("ajs", named for its 
owner) that lives in Fort Collins, Colorado ("fc") on an HP computer network 
("hp"), which is a kind of commercial network ("com").  

 You can think of domain names as being like postal addresses -- name, 
apartment, street, city, state, country. (Though most people don't realize it, the 
ZIP code is actually just another way to get to the name, apartment, and street 
parts, or sometimes just to the name, while ignoring the city, state, and country 
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parts. In exchange for making you deal with a few numbers, the post office can 
deliver your mail a lot faster and more accurately.)  

 Just like there are lots of different kinds of mail addresses, there are lots of 
different kinds of domain addresses. They're all of the form of words separated 
by dots, but the meanings of the first words in the name depend on which 
domain they're in, that is, which words appear later in the domain name.  

 Just like you can have both a street address and a post office box, a computer 
can be in different domains at the same time, although for various reasons this 
isn't very common.  

Nameservers: 

 Every domain or subdomain has at least one computer running a "nameserver" 
program, on a "well known port number", that can do name lookup. For example, 
if a client program on a computer named "jlk.co.edu" wants to talk with a service 
on server machine "ajs.fc.com", the steps work like this:  

 The client program on jlk.co.edu tells the computer system (jlk) it wants to 
make the connection.  

 jlk looks at "ajs.fc.com". Since it doesn't know anything about this 
address, it asks a world-wide top-level nameserver (at a known address) 
for the address of "ajs.fc.com". It gets the IP address of a nameserver for 
"com".  

 jlk asks the "com" server if it knows "ajs.fc.com". jlk gets an IP address for 
the nameserver for the "fc.com" subdomain.  

 jlk asks the "fc.com" server if it knows "ajs.fc.com". jlk gets an IP address 
for that system.  

 Now jlk connects to ajs by its IP address.  

 Suppose the client on jlk was a mailer (mail program) that wanted to send email 
to a person named "ajs" on the computer named "ajs". It would connect to the 
mail server's port (normally port 25), and say that it had mail for 
"ajs@ajs.fc.com". Note that while jlk might talk to a number of different systems 
in order to send the email, the letter itself would go directly to the destination 
system (across some patchwork of internet segments and gateways).  

 If the client was trying to send mail to "ajs@fc.hp.com", a computer named 
hpfcla.fc.hp.com might "take the call." It would say, "I know how to reach 
ajs@fc.hp.com" (who's really on ajs@ajs.fc.hp.com). hpfcla would accept the 
letter from jlk, then connect with ajs.fc.hp.com and forward it. This is especially 
common when the source system can't talk directly to the destination system 
because it's behind a "firewall", as described later.  
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Client/Server Concepts:  

 A client computer initiates a service request. A server computer waits to reply, 
kind of like a person who waits to answer the phone so you can make airline 
reservations.  

 A client program can be directed by a human being (at a screen, keyboard, and 
mouse), or it can run automatically.  

 A server is a program that knows a protocol for communication (see below), but 
often doesn't know much about networking -- it just exchanges bytes of 
information with the client, a back-and-forth conversation that might be human-
readable ASCII, or binary code; kind of like when you call someone to make a 
reservation, and they don't know how the phone system works, just how to use 
the telephone to talk with you.  

 It's entirely possible for the client and server programs to be on the same 
computer, as well as on two different computers connected by a network. The 
client/server model blurs the boundaries between computers, to where "the 
network IS the computer."  

 Once a virtual connection is established between a client and server, the two 
systems are peers, but the client/server asymmetry usually continues through 
the protocol; just like when you're done dialing someone, it doesn't matter much 
who placed the call, you can talk to each other as equals, though quite often the 
caller and the callee have very different roles. (With phone calls the caller usually 
pays for any long distance charges, but there's usually no equivalent in network 
connections.) 

 
Mark-up Languages: 

 A computer file is a series of bytes, usually in a code like ASCII that represents 
text (letters and digits), like English text.  

 When the text is simply lines of words, and each line ends with an ASCII 
"newline" character, we call that "flat ASCII".  

 A long time ago people realized that computers could be used to do document 
and book preparation. They are great at storing and manipulating text, and with 
printers they can print that text on paper.  

 "Flat ASCII" text is pretty flat-looking. Documents and books have lots of fancy 
features like layout, pagination, different fonts, chapter headings, drawings, etc. 
So people developed what are called "mark-up languages." These are ways of 
writing text intermingled with various formatting control commands that affect 
how the text is displayed or printed. For example, I might do something \fIlike 
this\fR to make some words appear in italics and the words after them return to 
normal (Roman) font.  
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Viewing and editing: 

 Once you have a document that is marked up in some way, you can view it two 
different ways. You can edit it as flat ASCII and hand-modify the formatting 
control commands, or you can view or print the document "pretty printed" so you 
can see what the control commands do.  

 Nowadays most mark-up languages are supported by WYSIWYG ("what you see 
is what you get" or "whizzywig") editors that let you edit the document in a form 
similar to how it will look when it's displayed or printed by the reader. You never 
need to see the control codes, but you have to know a language for talking with 
the editor about fancy features!  

 Often a WYSIWYG editor will let you "view the source" of the document so you 
can see the complicated control language.  

 Computers don't have to stop with pretty-printed words. It's possible for them to 
display pictures and symbols mixed with the words. Some of the symbols or 
words can even be made active, so when you "click on them" with a mouse, 
something happens.  

Hyperlinks: 

 One useful action is called a "hyperlink". This is a way of changing the display to 
show you a different document, or a different place in the current document. 
Pictures and words can both be made into hyperlinks. Text that is marked up to 
include hyperlinks is called "hypertext". Here's an example that shows you the 
control codes:  
 
<A HREF="#URL">Click here</A> to page-align the following table of contents.  

<a name="URL">First entry</a>...  
 
This means, turn "Click here" into a hyperlink with a hidden reference of "#URL", 
and if I click on it, move me down to the next paragraph (after the "<P>"), at 
"First entry...", which has a hidden name of "URL".  

 The "language" called HTML (hypertext mark-up language) is the common basis 
of the World Wide Web. Millions of HTML documents are stored on millions of 
networked computers. The example above is a simple little bit of HTML.  

 Currently, most people who write HTML documents edit flat ASCII forms of the 
documents, and then view them with a Web browser to see how they look 
formatted. This is kind of like writing software and then compiling it and running it 
to see how it works.  

 
What's a URL? 

 A Universal Resource Locator is a fancy name for a line of text that uniquely 
specifies a resource world-wide. A resource is usually, but not necessarily, a 
computer file.  
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 A URL starts with the name of a server or service; for example:  
 
ftp: 
http:  
 
The first service is FTP, the file transfer protocol you read about earlier. The 
second service is HTTP, "hypertext transfer protocol". It's a simple way to ask 
HTTP servers for HTML documents!  
 
(By convention, the FTP server always listens on port 21 on a server system, 
while the HTTP server lives on port 80.)  

 Normally the resource (text or image file) you want to access (view) is not on 
your own system, so the next piece of the URL is the domain name of the 
system where it lives; for example:  
 
http://ajs.fc.hp.com  

 The exact form of the URL depends on the type of service! For HTTP, the next 
piece is a path to the file, usually relative to the "home directory" for the HTTP 
server; for example:  
 
http://ajs.fc.hp.com/images/Megan.gif  
 
This means to return an image (graphics interchange language) file that lives in 
the HTTP home location under images/Megan.gif.  

 Finally, HTTP understands that after this part of the URL there can be a wide 
range of other symbols that aren't a file path name, but which carry information 
about the service request; such as the ticker symbol for a stock whose price to 
look up and return.  

 One of the cool things about URLs is that you don't have to keep local copies of 
documents. They only live at the source (on the source system), and any time 
you need to see them, you retrieve (download) a copy of the latest version -- 
assuming the server system is awake and you can reach it! In the past, people 
shared around many copies of on-line documents, and they developed elaborate 
schemes to try to ensure the latest copies were always distributed to all users.  

 But you should know that most web browsers "cache" local copies of files for a 
while. If you visit a website (URL) and return to it, often the return is pretty fast 
because a temporary local copy of the file is used. The only reason you need to 
know this is so it doesn't surprise you, and so you know what the "reload" button 
does for you.  

Bitmapped Graphics: 

 Once upon a time, to talk with a computer you had to press or flip switches and 
watch lights. ("Once upon a time" tells you this is a fairy tale and real life was 
much more complicated, but anyway...)  
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 Later people figured out how to build mechanical "teletypes" that were like 
typewriters, except the computer listened to your key presses and typed a reply 
to you on paper.  

 Later still, people figured out how to have computers display text and simple 
symbols on CRTs (cathode ray tubes, like TV sets but not exactly the same).  

 And even later, people figured out that computers didn't have to just display lines 
of text on these display screens. They could address individual bits on the 
screen to draw pictures, do all sorts of different sizes and fonts of text, etc. They 
could even put up "windows" that each acted like a separate physical display.  

 Along with bitmapped displays came new and different kinds of input devices 
than keyboards, such as mice and trackballs. With these "pointing devices" it 
was possible to "point and click" on a screen, choosing actions from "menus" 
instead of having to type "commands" to get things done.  

 Guess what! A hyperlink, in a hypertext document, displayed "pretty printed" on 
a screen, is a kind of "menu item"! The person who creates the document can 
easily "program" the "menu" without having to write any software (unless you 
count the mark-up language itself).  

Putting it All Together: 

 In the early 1990s all this technology -- client/server, internet, domain names, 
mark-up languages, and graphical displays -- began to come together. People 
were starting to store lots of documents, marked up in various ways for pretty-
printing, on networked computers, and running application programs that used 
windowed, graphical (bitmapped) displays and point-and-click interfaces.  

 Some people at CERN in Switzerland put together a markup language (HTML) 
with computer networking (client/server) and a new kind of server and protocol 
(HTTP), and with some new window-oriented, graphical, point-and-click software 
on the client side (a browser), to create the beginnings of the World Wide Web. 
Things really got going around 1993.  

 The Web grew like wildfire! Within just a few years, millions of documents had 
been created or converted to HTML and made available through HTTP servers. 
A variety of different web browsers (client-side programs) like Mosaic and 
Netscape were created and improved.  

 So what exactly is the World Wide Web? It doesn't really exist! It's "just" a 
collection of networked computers, internet connections, services and servers 
with lots of marked-up documents and pictures to share, and client-side 
browsers with which to view them. But when you put them all together, it's magic! 
The Web seems to have tangible substance.  

 What's a "homepage"? It's just an HTML document that is brought up by default 
when you connect to a particular server for HTTP. Often there are lots of 
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homepages available through one server, say, one for each user on the 
computer. You specify which one (whose homepage) you want, as part of the 
URL; for example: http://udltools.fc.hp.com/~ajs is a way of retrieving the 
homepage for user "ajs" from the HTTP server on "udltools". Homepages are 
usually starting places for following hyperlinks to details about a person or 
organization.  

 Suppose someone emails you a URL. "Check out this cool website/homepage." 
What can you do?  

 You can cut and paste the URL (on your local graphical, window-smart 
display, using a mouse) into a data entry form provided by the web 
browser, say, Netscape, on your display screen.  

 Netscape figures out from the URL that the protocol is HTTP; then as a 
client program, it asks the local computer to connect it to the domain 
name (computer) specified in the URL.  

 Along the way, if necessary, the client system looks up the IP address of 
the server computer from nameservers (and you get an error if that 
computer can't be reached).  

 After reaching the server system, the client system asks for the HTTP 
server by port number.  

 Then it tells the HTTP server program the rest of the gibberish in the URL.  

 Some time later the server responds with an HTML document (or with an 
error). This document is shipped back over the net to your web browser, 
and the connection is broken. (HTTP is "stateless", that is, it doesn't 
maintain a long-term relationship between the client and server. Each 
time the client needs something from the server, it makes a new, 
independent request. However, often times the new request includes 
saved information based on the previous request, such as form filled out 
by the user.)  

 The client-side web browser (Netscape) "pretty prints" this HTML 
document and displays it on the screen for you.  

 All of this takes place in just a few seconds. How long, depends on how busy are 
the network(s) between your client system and the server system, how busy are 
the two systems themselves, and how much data is to be transferred. (A picture 
might be worth a thousand words, but it's often worth a hundred thousand 
bytes.)  

 
Going Even Further: 

 Much of the time a website's URL is of the common form:  
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http://www.whatever.com  
 
and when people talk about the website, they leave off the "http://" part, or even 
all but the "whatever" part. Bear in mind that this is rather like giving a phone 
number without the area code.  

 Many computer networks are behind "firewalls". This means the computers in 
the organization can talk to each other and can connect to computers outside the 
firewall, but outside computers can't make inbound connections. This is why, for 
example, you can't reach some of the URLs I quoted above, from outside of HP.  

 Remember that automatic programs, not just people running programs, can be 
network clients. What happens when you write a "robot" that follows all the links 
it can, throughout the Web, and remembers in a database the URLs and titles 
and documents it's seen? You get a "web search engine", like the ones at:  
 
http://www.altavista.digital.com 
http://searcher.fc.hp.com/arachnophilia (HP-internal)  
 
You can tell these servers some words, and they locate all the web pages they 
know about that contain those words. Then they create (very fast, while you wait) 
a new, customized web page (HTML document) that includes hyperlinks to the 
other web pages that contain the words you wanted to find. Click! Off you go!  

 Most web browsers also have a way for you to record favorite URLs and their 
document titles, as "bookmarks" or "hotlists".  

 Remember that there is a protocol for every networked service... And there are 
lots of different kinds of computer services in common use. Guess what -- most 
web browsers know lots of protocols! They can not only talk HTTP/HTML, they 
can also talk FTP (bring back and display files for you), send and receive email, 
and read and post netnews. That is, they can be clients for a lot of different 
servers, presenting them all to you, the user, through a common style of 
graphical display.  

 The three most common types of computer services, which people get confused, 
are these:  

1. Electronic mail (email), exchanged using SMTP (simple mail transfer 
protocol) or other protocols. This is good for point-to-point 
communications, and for "broadcasting" using "mailing lists" or "mail 
reflectors" to lists of people. To send someone email, you need their email 
address, which is usually of this form:  
 
username@domain  
 
Conversations by email are slower and less interruptive than by 
telephone, but can be more precise, more easily shared widely, more 
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easily saved and reused, etc. Email combines features of both paper mail 
and telephones.  

2. Netnews (formerly called Usenet), exchanged using NNTP (network news 
transfer protocol) or other protocols. This is like a public bulletin board 
where anyone passing by can read what's on the board, tack up their own 
sheet of paper, and even send email to people who posted other notices. 
To achieve some sanity, old notices are automatically "taken down" 
(removed by the computer); discussions are grouped into "newsgroups" 
and then into "threads" (common titles or subjects) within each 
newsgroup.  
 
Newsgroups are great for widely sharing information, especially if it is 
periodic in nature, like a newsletter, or is well-suited for group discussion 
and debate. However, people often forget that all they see locally is a 
COPY of the bulletin board, with whatever "sheets of paper" have been 
copied and posted locally (to their system, or to a local news server 
system). There are delays, postings can get out of order, etc.  

3. Web pages -- usually HTML documents. This medium is rather like a 
highly interactive encyclopedia where anyone with access to a networked 
computer can add their own pages (and they are NOT alphabetized). It's 
great for finding information when you need it, but it's not so great for 
discussions or for knowing when new material arrives. People forget this 
and often share information by web pages that would be better shared by 
netnews.  

 What is "link rot"? That's when a hyperlink (in one HTML document) points to a 
computer or document that is moved, deleted, or no longer accessible. The link 
looks fine, but when you click on it you get an error. One of the sad truths about 
an anarchy like the World Wide Web is that link rot is common and unavoidable. 
This is one reason that in many cases it's better to search for a resource (using a 
web search engine) when you need it, than to record the URL.  

 What's "web surfing"? This means following hyperlinks, either from a search, or 
through a series of linked pages, or even at random, in the course of learning 
something, or just having fun. Kind of like flipping TV channels -- but less 
random!  
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Appendix 2. Website Access Errors 

 

Understanding website access errors 

As you surf the Net, you will undoubtedly find that at times you can't access certain 
websites. Why, you make wonder? Error messages attempt to explain the reason for 
that and other problems. Unfortunately, these cryptic messages baffle most people. 
We've deciphered the most common ones:  

400 - Bad Request 

Problem: There's something wrong with the address you entered. You may not be 
authorized to access the web page, or maybe it no longer exists.  

Solution: Check the address carefully, especially if the address is long. Make sure that 
the slashes are correct (they should be forward slashes) and that all the names are 
properly spelled. Web addresses are case sensitive, so check that the names are 
capitalized in your entry as they are in the original reference to the website.  

401 - Unauthorized 

Problem: You can't access a website because you're not on the guest list, your 
password is invalid or you have entered your password incorrectly.  

Solution: If you think you have authorization, try typing your password again. 
Remember that passwords are case sensitive.  

403 - Forbidden 

Problem: Essentially the same as a 401.  

Solution: Try entering your password again or move on to another site.  

404 - Not Found 

Problem: Either the web page no longer exists on the server or it is nowhere to be 
found.  

Solution: Check the address carefully and try entering it again. You might also see if 
the site has a search engine. If so, use it to hunt for the document. (It's not uncommon 
for pages to change their addresses when a website is redesigned.) To get to the home 
page of the site, delete everything after the domain name and hit the Enter or Return 
key. For example, if the address is: 
http://www.learnthenet.com/english/html/email.htm  
remove English/html/email.htm.  

503 - Service unavailable 

Problem: Your Internet service provider (ISP) or your Internet connection may be 
down.  

Solution: Take a stretch, wait a few minutes and try again. If you still have no luck, 
phone your ISP or system administrator.  

Bad file request 

Problem: Your web browser may not be able to decipher the online form you want to 
access. There may also be a technical error in the form.  
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Solution: Consider sending a message to the site's webmaster, providing any technical 
information you can, such as the browser and version you use.  

Connection refused by host 

Problem: You don't have permission to access the page or your password is incorrect.  

Solution: Try retyping your password if you think you should have access.  

Failed DNS lookup 

Problem: DNS stands for the Domain Name System, which is the system that looks up 
the name of a website, finds a corresponding number (similar to a phone number), then 
directs your request to the appropriate web server on the Internet. When the lookup 
fails, the host server can't be located.  

Solution: Try clicking on the Reload or Refresh button on your browser toolbar. If this 
doesn't work, check the address and enter it again. If all else fails, try again later.  

File contains no data 

Problem: The site has no web pages on it.  

Solution: Check the address and enter it again. If you get the same error message, try 
again later.  

Host unavailable 

Problem: The web server is down.  

Solution: Try clicking on the Reload or Refresh button. If this doesn't work, try again 
later.  

Host unknown 

Problem: The web server is down, the site may have moved, or you've been 
disconnected from the Net.  

Solution: Try clicking on the Reload or Refresh button and check to see that you are 
still online. If this fails, try using a search engine to find the site. It may have a new 
address.  

Network connection refused by the server 

Problem: The web server is busy.  

Solution: Try again in a while.  

Unable to locate host 

Problem: The web server is down or you've been disconnected from the Net.  

Solution: Try clicking on the Reload or Refresh button and check to see that you are 
still online.  

Unable to locate server 

Problem: The web server is out-of-business or you may have entered the address 
incorrectly.  

Solution: Check the address and try typing it again.  
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Most of us believe that our online activities are private and anonymous. In reality, 
everything thing you do online--whether it's searching for information, reading a news 
article, shopping for a gift or downloading music--is recorded. As you move through 
cyberspace you leave a trail of data in your path. This trail, often referred to as a 
clickstream, contains a revealing record of your online activity. 
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Appendix 3. Assignments  

Assignment for lesson #1 
 

1. What is Internet? 

2. Mention the program used to access computers in the internet? 

3. Open the following websites using address area 

a. www.tzads.com 

b. www.cnn.com 

c. www.google.com  

d. www.yahoo.com 

e. www.3bora.co.tz 

f. www.esis.ac.tz 

g. www.infocomcenter.com 

h. www.necta.go.tz  

i. www.tanzania.go.tz 

j. www.facebook.com 

 

4. Add the above sites in the favourite folder or location 

 

5. Delete www.3bora.com from the favourite location 

Assignment for Lesson #2 

1) List all basic buttons you have learnt so far in lesson #2 
2) What is different between:-  

a) Back and forward button 
b) Stop and refresh button 
c) Search and search engine? 

3) What button is used to send and read emails in internet explorer? 
4) Send the last website to infocom@habari.co.tz 

 

Assignment for lesson #3 

 

1. Search the following with and without quotes: 
1. Africa political Stability 
2. Arsenal players 
3. tips on preventing HIV/AIDS infections or spread 
4. Current Common Wealth Scholarships 
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Assignment for lesson #4 
 

1. What does URL represent? 
2. Mention three ways you can connect your computer to the internet 
3. Explain the type of the following website extensions 

a. com 
b. net 
c. org 
d. edu 
e. gov 
f. go.tz 
g. .co.tz 
h. .or.tz 
i. .sc.tz 
j. .mil.tz 
k. .ne.tz 
l. .ac.tz 

4. Go to the following websites: 
a. Harvard university 
b. Dell computer 
c. TTCL 
d. VODACOM 
e. ITV  
f. naomba 
g. IBM 
h. Compaq 
i. World Vision International 
j. Tanzania Official Website 

 
Assignment for lesson #5 
 

1. Mention three ways of saving internet information 
2. Go to www.google.com and select image then search for uk flag, then copy 

it to the new folder named international flags in C:\ directory 
 

Assignment for lesson 6 
 

1. Describe three necessary setup steps required before printing a web document 
 

Assignment for lesson #7 
 

1. What is Email 
2. Describe types of email managers 
3. What is Microsoft Outlook 
4. Compare the above with Outlook Express 
5. Where can you quickly open the Two of above email managers 
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Assignment for lesson 8 
 

1. Differentiate between internet based or webmails and locally based emails 
programs 

2. Differentiate between Microsoft Outlook and Outlook Express 
3. Write and application letter requesting position of sales manager with 

InfoCom Center.  Address the letter to the managing Director. Use 
infocom@habari.co.tz 

 

Assignment for lesson #9 
 
Send the messages and receive them in your own email account 

 
Assignment for lesson #10 
 

1. Print the email message  
a. Follow the steps to print an email message 

i. Set the printer at A4 paper size 
ii. Select the printer type of your interest 
iii. Set grey printing in printer preference 
iv. Print current page 
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Appendix 4. Tests 

 

Introduction to internet and emails 
Tests for Lesson 1-4 

Answer all questions 

Duration: 30mins 

 

1. What is Internet? 

2. What is Internet Explorer? 
3. List all internet explorer basic buttons 
4. Send www.google.com website to infocom@habari.co.tz 
5. Search the following: 

1. Tanzania ministry of agriculture budget overview 
2. Simple ways to learn Internet online 
3. How to write a business proposal? 

6. What does URL represent?                                                                                                                                                      
7. Mention three ways of internet connection 
8. Explain the meaning of the following website extensions 

1. com 
2. net 
3. org 
4. edu 
5. co.tz 
6. co.uk 
7. gov 
8. go.tz 

9. Go to the following websites: 
1. University of dare s salaam 
2. TTCL 
3. CELTEL 
4. CNN business  
5. Africa tours guide centers 
6. World Vision International 
7. Federal Government Official Website 
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Introduction to Internet and emails – test for lesson 5-9 
Answer all questions 
 
Duration: 30 Mins 
 
1. Mention three ways of saving internet information 
2. Go to www.yahoo.com and select image then search for Philippines flag, then copy 

it to the new folder named international flags in C\:\ directory 
 
3. Mention features available in page setup while printing web information 
4. What is Outlook Express? 
5. What is Microsoft Outlook? 
6. What do you understand by webmails managers? 
7. What do you understand by Local Computer Based email managers? 
8. Describe the advantage and disadvantage of each type in 6&7 
9. Print the webpage as follows 

1. Set the printer at A4 paper size 
2. Select your printer 
3. Set grey printing at printer preference 
4. Print all pages 
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Appendix 5. Final Examination 

 
Introduction to internet and emails 

Final Examination 

This paper carries 50% of all final results toward Internet and emails performance and achievement 

 

Answer all questions 

Duration: 60mins 

 

10. What is Internet? 

11. Mention the windows program used to browse the internet  
12. Send www.google.com website to infocom.center@yahoo.com 
13. Search the following: 

1. Israel flag image 
2. Free online Internet training 
3. how to download files in the internet 
4. How to send e-cards 
5. Free auction centers 

 
14. Mention three ways of internet connection 
15. Explain the meaning of the following website extensions 

1. com 
2. net 
3. org 
4. edu 
5. co.tz 
6. gov 
7. go.tz 

 
16. Mention three ways of saving internet information 
17. What is the advantage of web mail over local mail managers  
18. What is the advantage of local mail managers over web mail 
19. Mention three basic printing procedures for website information 
 
 
 
 


